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About the PRODIGY Software for Windows
Please Select a Topic:

What the PRODIGY Installation Program Does 

Recommended Hardware and Software Requirements 



What the PRODIGY Installation Program Does
The PRODIGY Software for Windows Installation Program performs several functions:

It checks to see if your computer is running Windows 3.1 or greater.
It makes sure that all the files required to install the PRODIGY software are on the PRODIGY 

Installation Disk.
It makes sure that you have enough room in the hard drive/directory you name to install the 

PRODIGY software.
It checks for the latest versions of common Windows resource files and copies them to your 

computer, if necessary.
It copies PRODIGY Software files to your hard drive and updates your Windows desktop.
Install replaces previous versions of the PRODIGY software if you install to the same directory.    

Installing over previous versions of the PRODIGY software will retain modem and phone settings.

Once installed, the PRODIGY service is just a phone call away!
See Also

Recommended Hardware and Software Requirements 



Recommended Hardware and Software Requirements
The following hardware and software are recommended for use with the PRODIGY software:

PC with 16MHz/80386 (or higher) microprocessor;
3 1/2 MB available hard drive space;
4MB (or higher) RAM;
3.5" disk drive;
VGA (or higher) graphics adapter and monitor;
DOS version 3.0 (or higher);
Microsoft® Windows 3.1(TM) or higher;
Hayes® compatible 2400 or 9600 bps modem;
Additional disk space if you plan to save data to file during a PRODIGY service session.

See Also

Starting Windows in Standard or Enhanced Mode 



Troubleshooting - Installation
Select the Error Code or Message You Received

This program requires Microsoft Windows 

This program requires a new version of Microsoft Windows 

This application requires Standard or Enhanced Mode Windows 

Cannot find file or one of its components 

W1 Unable to Start Installation 

W2 Unable to Start Installation 

W3 Unable to Start Installation 

W4 Unable to Start Installation 

W5 Unable to Start Installation 

W100 & W101 Unable to Load DLL 

W102 Unable to Load DLL 

W110 Unable to Find INF File 

W111 Unable to Load INF File 

W120 Invalid Destination Path 

W121 Not Enough Space on Drive 

W122 Unable to Obtain Drive Information 

W123 Drive Does Not Exist 

W125 Unable to Create Directory 

W126 Unable to Delete Old File 

W150 Hard Drive Not Found 

W151 Free Space Not Found 

W211 Destination Same As Source 

W225 Unable to Execute Function 

W250 Unable to Install Windows DLL 

W251 Unable to Install Windows DLL 

W252 Unable to Install Windows DLL 

W253 Unable to Install Windows DLL 

W260 Unable to Install Windows DLL 

W261-W265 Unable to Install Windows DLL 

W266 Unable to Install Windows DLL 

W267 Unable to Install Windows DLL 

W268-W270 Unable to Install Windows DLL 

W300 Unable to Copy File 

W301 Unable to Copy File 

W302 Unable to Copy File 

W303 Unable to Copy File 



W304 Unable to Copy File 

W305-W307 Unable to Copy File 

Windows will not restart 



This program requires Microsoft Windows
You must run the Installation program from Windows 3.1 or higher. To do this:

1. At the DOS prompt, type: win and press [Enter]

2. From the File menu, select Run
3. Enter the full pathname for the Installation program, (for example, a:\install)
See Also

Using File Manager 

Reporting Problems 



This program requires a new version of Microsoft Windows
The Installation program and the PRODIGY Software for Windows require Microsoft Windows 3.1 or 
higher.    We recommend that you upgrade to Windows version 3.1 or greater.
See Also

Reporting Problems 



This application requires Standard or Enhanced Mode Windows
You must run Windows in Standard or Enhanced mode to use the PRODIGY software for Windows.
See Also

Starting Windows in Standard or Enhanced Mode 

Reporting Problems 



Cannot find file or one of its components
If you attempted to run INSTALL.EXE from the Program Manager, the wrong pathname was likely 
specified. Verify the full pathname and try again. For example, type: a:\install.exe
See Also

Reporting Problems 



W1 Unable to Start Installation
Exit Windows. Power down your system, then power it back up. Restart Windows. Run the PRODIGY 
Installation program again without any other applications active.
See Also

Reporting Problems 



W2 Unable to Start Installation
To start the Installation program from a floppy disk, Windows requires that you have at least 100,000 
bytes available on a hard drive it selects (usually Drive C). To successfully install the PRODIGY software 
for Windows, you must have at least 3 1/2 MB of free space on the destination drive you select.

You can:
Attempt to make more space available by deleting files you don't need.

See Also

Reporting Problems 



W3 Unable to Start Installation
Windows creates a temporary directory while installing the PRODIGY software.    A file with the same 
name as the temporary directory already exists on the hard drive. You can:

Rename the file. 

If you have additional problems creating a directory, please refer to your DOS manual.
See Also

Using File Manager 

Reporting Problems 



W4 Unable to Start Installation
You have used an incorrect installation disk.    Make sure that the PRODIGY Installation Disk #1 is in the 
disk drive and try again.
See Also

Obtaining Replacement Disks 

Reporting Problems 



W5 Unable to Start Installation
You have used an incorrect installation disk.    Make sure that the original PRODIGY Installation Disk is in 
the disk drive and try again.
See Also

Obtaining Replacement Disks 

Reporting Problems 



W100 & W101 Unable to Load DLL
Check the PRODIGY Installation Disk and verify that the following files exist: VER.DLL and 

METER.DLL.
If both are present, restart Windows and run the Installation program again. 
If either file is not on the PRODIGY Installation Disk, obtain a new PRODIGY Installation Disk.

See Also

Using File Manager 

Obtaining Replacement Disks 

Reporting Problems 



W102 Unable to Load DLL
Check the directory where you have installed Windows for the file LZEXPAND.DLL. 
If it is present, restart Windows and run the PRODIGY Installation program again. 
If it is missing, reinstall Windows.

See Also

Using File Manager 

Reporting Problems 



W110 Unable to Find INF File
Check the PRODIGY Installation Disk for the file INSTALL.INF. 
If it is present, restart Windows and run the PRODIGY Installation program again.
If the file is not on the PRODIGY Installation Disk, obtain a new PRODIGY Installation Disk.

See Also

Using File Manager 

Obtaining Replacement Disks 

Reporting Problems 



W111 Unable to Load INF File
Exit Windows. Power down your system then power it back up.    Restart Windows. Run the PRODIGY 
Installation program again without any other applications active.
See Also

Reporting Problems 



W120 Invalid Destination Path
You did not correctly enter the full pathname of the drive and directory where you want the PRODIGY 
software installed.    Enter the proper pathname and try again.    Refer to your DOS manual for more 
information on pathnames.
See Also

Reporting Problems 



W121 Not Enough Space on Drive

The hard drive you specified to install the PRODIGY software to does not have enough free space. This 
software requires a minimum of 3 1/2 MB of free disk space. You should have more if you anticipate 
sending data to disk files. You can:

Attempt to make more space available by deleting files you don't need.
Choose another hard drive destination, if available.

See Also

Reporting Problems 



W122 Unable to Obtain Drive Information
A problem was encountered with the hard drive you specified.

Run CHKDSK from the DOS prompt to determine if any problems exist with your hard drive.
See Also

CHKDSK 

Reporting Problems 



W123 Drive Does Not Exist
The destination drive you have specified does not exist. Determine the correct hard drive destination and 
try again.
See Also

Using File Manager 

Reporting Problems 



W125 Unable to Create Directory
The hard drive you have specified to install to already has a file with the same name as the directory you 
are attempting to create. You can:

Rename the file, or 
Enter a new directory name.

If you have additional problems creating a directory, please refer to your DOS manual.
See Also

Using File Manager 

Reporting Problems 



W126 Unable to Delete Old File
You are most likely attempting to install the new PRODIGY Software for Windows over the old PRODIGY 
software and one or more of the old files is write-protected. Change the read-only attribute and run the 
PRODIGY Installation program again.
See Also

Viewing and Changing File Attributes 

Reporting Problems 



W150 Hard Drive Not Found
The PRODIGY Software for Windows Installation program requires a hard drive.    To determine whether 
your system has a hard drive use:

File Manager
See Also

Using File Manager 

Reporting Problems 



W151 Free Space Not Found
You do not have enough free hard drive space on the drive you specified to install the PRODIGY 
software. This software requires 3 1/2 MB of free disk space. You will need more space if you anticipate 
sending data to disk files. You can:

Attempt to make more space available by deleting files you don't need.
Choose another hard drive destination, if available.

See Also

Reporting Problems 



W211 Destination Same As Source
The drive you have specified to install to is the same drive that the PRODIGY Installation software is on.    
You must select a different drive to install to.
See Also

Reporting Problems 



W225 Unable to Execute Function
Exit Windows. Power down your system then power it back up.    Restart Windows. Run the PRODIGY 
Installation program again without any other applications active.
See Also

Reporting Problems 



W250 Unable to Install Windows DLL
It is most likely that one or more older version DLLs is write-protected. Change the read-only attribute and
run the PRODIGY Installation program again.
See Also

Viewing and Changing File Attributes 

Reporting Problems 



W251 Unable to Install Windows DLL
The disk drive where your Windows software is located does not have enough free space to 
replace/install a Windows DLL. Create more space on the Windows drive and re-install the PRODIGY 
software.
See Also

Using File Manager 

Reporting Problems 



W252 Unable to Install Windows DLL
Exit Windows. Power down your system then power it back up.    Restart Windows. Run the PRODIGY 
Installation program again without any other applications active.
See Also

Reporting Problems 



W253 Unable to Install Windows DLL
There is an inconsistency with your Windows DLL. Contact 1-800-PRODIGY (1-800-776-3449) or further 
assistance.
See Also

Reporting Problems 



W260 Unable to Install Windows DLL
Exit Windows. Power down your system, then power it back up. Restart Windows. Run the PRODIGY 
Installation program again without any other applications active.

If this does not work then the problem is most likely that the PRODIGY Installation program cannot copy a
Windows DLL to your computer. A previous copy of the DLL is on your computer but is locked and cannot 
be overwritten.

You will need to:

1. Change the file attributes of the DLL from "read only" or "hidden" to "read/write"

2. Run the PRODIGY Installation program again.
See Also

Viewing and Changing File Attributes 

Reporting Problems 



W261-W265 Unable to Install Windows DLL
Exit Windows. Power down your system, then power it back up. Restart Windows. Run the PRODIGY 
Installation program again without any other applications active.
See Also

Reporting Problems 



W266 Unable to Install Windows DLL
There is an inconsistency with your Windows DLL. Contact 1-800-PRODIGY (1-800-776-3449) or further 
assistance.
See Also

Reporting Problems 



W267 Unable to Install Windows DLL
Be sure you're using your original Installation Disks. If you still receive this error, call 1-800-PRODIGY (1-
800-776-3449).
See Also

Obtaining Replacement Disks 

Reporting Problems 



W268-W270 Unable to Install Windows DLL
Exit Windows. Power down your system, then power it back up. Restart Windows. Run the PRODIGY 
Installation program again without any other applications active.
See Also

Reporting Problems 



W300 Unable to Copy File
A file could not be copied to the drive/directory you indicated. Choose another destination drive or 
directory and try again.
See Also

Using File Manager 

Reporting Problems 



W301 Unable to Copy File
Exit Windows. Power down your system then power it back up. Restart Windows. Run the PRODIGY 
Installation program again without any other applications active.
See Also

Reporting Problems 



W302 Unable to Copy File
The destination drive you have specified does not exist. Determine the correct hard drive destination and 
try again.
See Also

Using File Manager 

Reporting Problems 



W303 Unable to Copy File
The destination drive you have specified does not exist. Determine the correct hard drive destination and 
try again.
See Also

Using File Manager 

Reporting Problems 



W304 Unable to Copy File
A problem was encountered during Install because you have File Sharing enabled. You will need to:

Disable File Sharing,
Restart your computer,
Run the PRODIGY Installation program again without any other applications active.

See Also

How to Disable File Sharing 

Reporting Problems 



W305-W307 Unable to Copy File
Exit Windows. Power down your system then power it back up. Restart Windows. Run the PRODIGY 
Installation program again without any other applications active.
See Also

Reporting Problems 



Windows will not restart
You probably have an open application (e.g., DOS box). You should:

Close the application;
Restart Windows. 

See Also

Reporting Problems 



Troubleshooting - Connecting to the Service
Select the Error Code You Received

CM 4 at connect time 

CM 4 a few minutes after connecting 

CM 6 at connect time 

CM 6 a few minutes after connecting 

CT 08 

CT 15 

CT 16 

CT 17 

CT 18 

CT 20 

CT 21 

CT 24 

CT 25 

CT 29 

CT 35 

CT 36 

CT 39 

CT 41 

CT 42 

CT 45 

CT 46 

LTM 35 



CM 4 at connect time
The connection between the PC and PRODIGY's local site was lost.

 Make sure that you have the correct Network Symbol that corresponds with the PRODIGY phone
number you are using.

Your modem may have MNP, Error Correction, Flow Control and/or Data Compression enabled. 
Use the ASSIST Utility located in your PRODIGY directory to append commands to the modem 
initialization string. Doing so will disable these features.

There may be a communications port or IRQ conflict. Use the ASSIST Utility located in your 
PRODIGY directory to help locate the problem.

There may be excessive noise on the line. Try dialing another nearby PRODIGY phone number.
See Also

Using ASSIST 

Reporting Problems 



CM 4 a few minutes after connecting
The connection between the PC and PRODIGY's local site was lost.

Your modem may have MNP, Error Correction, Flow Control and/or Data Compression enabled. 
Use the ASSIST Utility located in your PRODIGY directory to append these commands to the modem 
initialization string. Doing so will disable these features.

There may be a communications port or IRQ conflict. Use the ASSIST Utility located in your 
PRODIGY directory to help locate the problem.

If you have call waiting you may be getting a call. The signal to tell you there is another call will 
cause the connection to fail. If your local telephone company supports disabling call waiting, try disabling 
it. For a Tone type phone line, precede the telephone number with *70; Pulse or rotary phone line use a 
1170.

There may be excessive noise on the line. Try dialing another nearby PRODIGY phone number.
See Also

Using ASSIST 

Reporting Problems 



CM 6 at connect time
The connection between the PC and PRODIGY's local site was lost.

Check in Set-up that you have the correct Network Symbol for the telephone number you are 
calling.

Your modem may have MNP, Error Correction, Flow Control and/or Data Compression enabled. 
Use the ASSIST Utility located in your PRODIGY directory to append these commands to the modem 
initialization string. Doing so will disable these features.

There may be a communications port or IRQ conflict. Use the ASSIST Utility located in your 
PRODIGY directory to help locate the problem.

There may be excessive noise on the line. Try dialing another nearby PRODIGY phone number.
See Also

Using ASSIST 

Reporting Problems 



CM 6 a few minutes after connecting
The connection between the PC and PRODIGY's local site was lost.

Your modem may have MNP, Error Correction, Flow Control and/or Data Compression enabled. 
Use the ASSIST Utility located in your PRODIGY directory to append these commands to the modem 
initialization string. Doing so will disable these features.

There may be a communications port or IRQ conflict. Use the ASSIST Utility located in your 
PRODIGY directory to help locate the problem. Refer to the Troubleshooting section.

If you have call waiting you may be getting a call. The signal to tell you there is another call will 
cause the connection to fail. If your local telephone company supports disabling call waiting, try disabling 
it. For a Tone type phone line, precede the telephone number with *70; Pulse or rotary phone line use a 
1170.

There may be excessive noise on the line. Try dialing another nearby PRODIGY phone number.
See Also

Using ASSIST 

Reporting Problems 



CT 08
Modem response to the dial command was not valid. The modem initialization string that the PRODIGY 
software has selected does not appear to be working with your modem.

You will need to use the ASSIST Utility included in your PRODIGY directory to change your modem 
settings. Using ASSIST, you will need to:

1. Disable your modem's extended dial and connect message responses.

2. Disable your modem's MNP, Error Correction, Flow Control and Data Compression features.

There may also be a Communications Port or IRQ Conflict. Use the ASSIST utility to help locate the 
problem.
See Also

Using ASSIST 

Reporting Problems 



CT 15 or CT 42
Modem response to the ATE0 command was not valid.

If you have an external modem, exit the PRODIGY software, turn the modem off and on, and 
restart PRODIGY.

Your modem may not support the modem speed you specified in the Set-up window of the 
PRODIGY software.    Choose a lower modem speed and try dialing the PRODIGY service again.

There may be a conflict between two of your communications ports. Use the ASSIST Utility 
located in your PRODIGY directory to determine whether you have a Com Port problem.

An alternate method is to use ASSIST to edit the PRODIGY.INI file in your PRODIGY directory. At
the DOS prompt, type: ASSIST 1

If you have set your modem speed to 14,400 bps, run ASSIST. At the Welcome menu, select 
Expert Mode. Then select Compatibility (F6), select the option for High Speed Modem Support and follow 
the instructions provided.
See Also

Using ASSIST 

Reporting Problems 



CT 16 or CT 25
The modem dialed and returned "No Carrier".

If you have been able to connect to the PRODIGY service before, then the number you are 
dialing may be busy or having technical difficulties. Try using your alternate phone number or try the 
service again later.

Make sure you are not dialing your own phone number.
Check to make sure that your telephone line is plugged in and working properly.
Check to see that you are not dialing an invalid prefix such as 1 , 1170, *70 or your area code 

when it is not needed. If you are calling from an office you may need a 9 to get an outside line.
Check to see if you have the type of phone service set to the correct setting (i.e., PULSE if you 

have a rotary dial phone or TONE if you have a touch tone phone).
Your modem may have MNP, Error Correction, Flow Control and/or Data Compression enabled. 

Use the ASSIST Utility located in your PRODIGY directory to append these commands to the modem 
initialization string. Doing so will disable these features.

If you are running a fax program in the background, try disabling it before running the PRODIGY 
software.

There may be a Communications Port or IRQ Conflict. Use the ASSIST Utility to help locate the 
problem.
See Also

Using ASSIST 

Reporting Problems 



CT 17
The modem was unable to detect a dial tone.

Check to make sure that your telephone line from the modem to the wall jack is plugged in and working 
properly.    For example, plug a telephone cable into your wall jack, then plug the other end of the cable 
into your modem where it says "Line", "Wall", or "Telco".
See Also

Reporting Problems 



CT 18
The modem has detected a busy signal.

Make sure you are not dialing your own phone number or an incorrect number.    A simple test is 
to pick up the phone and dial the number you entered for the PRODIGY service. If you hear a high pitch 
tone when the other phone answers then the number is valid. If not, check the number again and repeat 
the test until you get the high pitch tone.

Try dialing your alternate phone number or look up another number close to you in the PRODIGY 
Phone Directory.

Try again later.
See Also

Reporting Problems 



CT 20 or CT 24
The PRODIGY Software cannot communicate with your modem.

Use the ASSIST Utility included in your PRODIGY directory to determine the Com Port of your 
modem.

Open the PRODIGY software by double clicking on the PRODIGY icon. Click on Set-up. Select 
Com Ports. Insure that the Com Port is set to the setting of your modem.

Open the Main group. Click on Control Panel. Click on Ports. Click on the Com Port that your 
modem is on. Be sure that the address and IRQ match the configuration of your modem.

Use the ASSIST Utility included in your PRODIGY directory to determine if you have a Com Port 
conflict. If you do, contact your computer dealer for details on how to fix it.

An alternate method is to use ASSIST to edit the PRODIGY.INI file in your PRODIGY directory. At
the DOS prompt, type: ASSIST 1

If you have set your modem speed to 14,400 bps, run ASSIST. At the Welcome menu, select 
Expert Mode. Then select Compatibility (F6), select the option for High Speed Modem Support and follow 
the instructions provided.
Note: Windows often identifies Com Ports differently than DOS. Try choosing each Com Port in 
descending order until your modem dials.
See Also

Using ASSIST 

Checking Port Settings Under Windows 

Reporting Problems 



CT 21
The PRODIGY software file, MODEMS.TXT, cannot be found.

Reinstall the PRODIGY software.
See Also

Reporting Problems 



CT 29 or CT 46
The modem connected to the PRODIGY network but was unable to logon to the PRODIGY service.

The PRODIGY phone number that you dialed may be having technical problems. Please try 
again later.

Check to make sure that you are using the correct Network Symbol for the number you are 
dialing.

You may have to disable MNP, Error Correction, Flow Control and\or Data Compression on your 
modem. Use the ASSIST Utility located in your PRODIGY directory to help you do this.    Doing so will 
disable these features.

Try using the    Network Symbol "R" for the number you are dialing.

See Also

Using ASSIST 

Reporting Problems 



CT 35 or CT 45
The PRODIGY software file, SCRIPT.Y or SCRIPT.R, is missing or corrupted. Reinstall the PRODIGY 
software from the original Installation disk.
See Also

Reporting Problems 



CT 36
The modem did not respond correctly to the ATD command.

Use the ASSIST Utility located in your PRODIGY directory to help locate the problem.
An alternate method is to use ASSIST to edit the PRODIGY.INI file in your PRODIGY directory. At

the DOS prompt, type: ASSIST 1
See Also

Using ASSIST 

Reporting Problems 



CT 39
The modem did not respond correctly to the initialization commands.

You may have appended an invalid custom modem command using ASSIST. Try removing it or 
appending another modem command.

Use the ASSIST Utility located in your PRODIGY directory to determine if you have a Com Port 
conflict. If you do, contact your computer dealer for details on how to fix it.

An alternate method is to use ASSIST to edit the PRODIGY.INI file in your PRODIGY directory. At
the DOS prompt, type: ASSIST 1
See Also

Using ASSIST 

Reporting Problems 



CT 41
The modem does not support the S registers contained in the modem initialization string.

Use the ASSIST Utility located in your PRODIGY directory to help locate the problem.
An alternate method is to use ASSIST to edit the PRODIGY.INI file in your PRODIGY directory. At

the DOS prompt, type: ASSIST 1
See Also

Using ASSIST 

Reporting Problems 



LTM 35
The connection between the PC and PRODIGY's local site was lost.

Your modem may have MNP, Error Correction, Flow Control and/or Data Compression enabled. 
Use the ASSIST Utility located in your PRODIGY directory to append these commands to the modem 
initialization string. Doing so will disable these features.

There may be a communications port or IRQ conflict. Use the ASSIST Utility located in your 
PRODIGY directory to help locate the problem.

There may be excessive noise on the line. Try dialing another nearby PRODIGY phone number.
See Also

Using ASSIST 

Reporting Problems 



Using Windows
The following topics are provided to help you troubleshoot problems you may encounter while installing or
running the PRODIGY software for Windows. For complete information about using Windows, consult 
your Windows User's' Guide.
Select a Topic

Starting Windows in Standard or Enhanced Mode 

Using File Manager 

Checking Port Settings Under Windows 

Getting to DOS from Windows 



Starting Windows in Standard or Enhanced Mode
The Standard mode of Windows accesses extended memory your computer may have and lets you 
switch among non-Windows applications. To use Standard mode, you must have a 286 computer or 
better, and at least 1 megabyte of memory. The PRODIGY software for Windows requires 4 megabytes of
memory in standard mode.

The Enhanced mode of Windows provides access to virtual memory on your computer and lets you multi-
task Windows and non-Windows applications. To use Enhanced mode, you must have a 386 computer or 
better, and at least 2 megabytes of memory. The PRODIGY software for Windows requires 4 megabytes 
of memory in enhanced mode.

To determine the Windows mode in which your computer is running:

1. Select Help from the Program Manager Menu Bar.

2. Select About Program Manager...

The About box tells you what version of Windows you are running, what mode you are using, and the 
amount of memory available.

To run Windows in Standard mode, type: win /s at the DOS prompt.

To run Windows in Enhanced mode, type: win /e at the DOS prompt.



Using File Manager
The File Manager icon is located in the Main Group on your Windows desktop. From File Manager, you 
can run other applications, check the disk drives available on your computer, check what files and 
directories exist on your computer, check file attributes and much more. Some of the key features of File 
Manager appear below.    You might find these topics helpful if you encounter a problem installing the 
PRODIGY software. Refer to your Windows User's Guide for more information on using these and other 
features.
Select a Topic

Running the PRODIGY Installation Program from File Manager 

Checking the Contents of the PRODIGY Installation Disk 

Checking the Contents of a Directory 

Viewing and Changing File Attributes 



Running the PRODIGY Installation Program from File Manager
1. Open the Main Group, if it is not already open.

2. Double click on the File Manager icon.

3. Click on the drive icon for the drive containing the PRODIGY Installation Disk.

4. Double click on the file you want to launch, for example, INSTALL.EXE.



Checking the Contents of the PRODIGY Installation Disk
1. Open the Main Group if it is not already open.

2. Double click on the File Manager icon.

3. Click on the drive icon for the drive containing the PRODIGY Installation Disk.

4. Examine the contents of the disk.



Checking the Contents of a Directory
1. Open the Main Group if it is not already open.

2. Double click on the File Manager icon.

3. Click the drive icon where the desired directory is located.

4. Click the folder icon for the directory you want.

5. Examine the contents of    the directory.



Viewing and Changing File Attributes
Viewing File Attributes

1. Open the Main Group if it is not already open.

2. Double click on the File Manager icon.

3. Select the drive and directory you are interested in, for example "c:\prodigy"

3. Select All File Details from the View Menu.

4. An "r" next to any file name means the file is "read only"; to successfully install the PRODIGY 
software, the file's attribute needs to be changed to "read/write".

5. File Attributes must be changed from DOS. See Changing File Attributes below for more 
information. 

Changing File Attributes

1. Double click on the DOS icon (in the Main Group in Windows 3.1).

2. Change to the directory whose file attributes you want to check.    For example, to check the 
attributes of PRODIGY software already on your computer, type: cd\prodigy. To check the 
attributes of your Windows software, change to the directory where Windows is installed, for 
example, type: cd\windows

3. Then type: attrib and press [Enter], to see file attributes listed.
A = Archive
H = Hidden
R = Read Only
S = System

4. To change "R" read only to read/write type: attrib -r /s
5. To change "H" hidden only to read/write type: attrib -h /s
6. To return to Windows, type: exit at the DOS Prompt.



Checking Port Settings Under Windows
1. Open the Main Group if it is not already open.

2. Double click the Control Panel icon.

3. Double click the Ports icon.

4. The current Com Port setting recognized by Windows will be highlighted. Refer to your Windows 
User's Guide for more information on changing port settings.

5. Choose the port for which your modem is configured (see modem manual). The address and IRQ
shown in Windows must match.



Getting to DOS from Windows
You can get to DOS from Windows in one of two ways: 

You can "shut down" Windows and remove it from memory; or
You can "shell" out of Windows to the DOS command line. In this case, Windows is still in 

memory and you can easily return to it.

You should "shut down" Windows if you need to use ASSIST or make changes to any hardware or 
software settings that Windows uses.      You can "shell" out of Windows if you simply need to check the 
contents of a disk or make space available on your hard drive.

To "shut down" Windows:

1. Select Exit from the Program Manager File menu.

2. Click on the Yes button to leave Windows.

To return to Windows following a "shut down":
Type: win at the DOS prompt.

To "shell" out of Windows:

Double click on the DOS icon (in the Main Group in Windows 3.1).

To return to Windows:
Type exit at the DOS prompt, or
Press [Ctrl]+[Esc].



How to Disable File Sharing
1. Open the Accessories Group, if it's not already open.

2. Double click on the Notepad icon.

3. Select Open from the File menu.

4. Type: c:\autoexec.bat (where c:\ is the hard drive you use to boot your computer and 
autoexec.bat is the name of the batch file run each time you turn on your computer.)

5. Browse the file to see if a line similar to the following exists:
C:\DOS\SHARE.EXE 

6. If you did not find this line, close the Notepad and go to Step 9.

7. If you find the line, move your cursor to the beginning of that line and type:    REM    and then a 
space.    The line should now look like this:

REM C:\DOS\SHARE.EXE.

When you restart your computer this line will not be executed.

8. Save the file and close the Notepad.

9. Restart your computer.

10. Start Windows.

11. Run the PRODIGY Installation program again.

Important:    There may be other applications on your computer that require File Sharing. If you 
successfully install the PRODIGY software for Windows after you have added REM to your autoexec.bat 
file, you should repeat steps 1-5 above and remove "REM " from the line, and repeat steps 8-10.



CHKDSK
1. Shut down Windows by selecting Exit from the Program Manager File menu.

2. Click on the Yes button to leave Windows.

3. Change to the directory where your DOS programs reside, for example type: cd \dos
4. Type: chkdsk. If you are checking a drive other than the one you're currently on, you must also 

specify the drive. For example, type: chkdsk a:
5. Refer to your DOS manual for more information on using chkdsk and interpreting its results.



Using ASSIST
ASSIST is a collection of utilities that help isolate potential problems and display information about your 
system.

To access ASSIST:
Double-click the ASSIST icon; Or,
Exit Windows. At the DOS prompt type: cd\prodigy or the directory name where PRODIGY is 

installed. Then type: assist and press [Enter].

Note: Windows controls com ports and may give you inaccurate results. Therefore, it's best to access 
ASSIST from the DOS prompt.



Reporting Problems
1. Follow the instructions in Troubleshooting Help to resolve your problem.

2. If you are unable to resolve an installation or pre-sign on problem, call 1-800-PRODIGY (1-800-
776-3449).

3. If you are unable to resolve a problem that occurs following sign on, Jump: member services (or 
select Member Services from the Help pull-down) and send a message describing your problem.

4. If you still need help, call 1-800-PRODIGY (1-800-776-3449).



Obtaining Replacement Disks
If you continue to experience problems installing the PRODIGY software for Windows, you can obtain 
replacement disks by calling 1-800-PRODIGY (1-800-776-3449).




